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1. Analog Input

• 8 analog input channelsA0−A7

• Board input:0− 5 V analog signal

• Block output: unipolar or bipolar amplitude of analog signal

• Resolution:12 bit

• Sampling rate:28.7891 kHz (internal)

• 610.3516 µV maximum unipolar amplitude quantization error and1220.7031 µV maximum bipolar

amplitude quantization error
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SIMLAB Simulink

unipolar mode ⇒ v ≈







5, u ≥ 5
u, 0 < u < 5
0, u ≤ 0

bipolar mode ⇒ v ≈







+5, u ≥ 5
2u− 5, 0 < u < 5
−5, u ≤ 0
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2. Analog Output

• 8 analog output channelsB0− B7

• Block input: unipolar or bipolar amplitude of analog signal

• Board output:0− 5 V analog signal

• Resolution:12 bit

• Settling time:6.0 µs

• 610.3516 µV maximum unipolar amplitude interpolation error and1220.7031 µV maximum bipolar

amplitude interpolation error
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unipolar mode ⇒ u ≈







5, v ≥ 5
v, 0 < v < 5
0, v ≤ 0

bipolar mode ⇒ u ≈







5, v ≥ +5
v/2 + 5/2, −5 < v < +5
0, v ≤ −5
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3. Digital Input

• 1 digital input channelC0 with 8 digital input linesc0− c7

• Board input:0− 5 V digital signal

• Block output: decimal representation of digital signal
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c7

c0

u7

u0

···

v = 128 c7 + 64 c6 + 32 c5 + 16 c4 + 8 c3 + 4 c2 + 2 c1 + 1 c0

ci =







ui (1 or 0), ci is used (ci is checked)
0, ci anddi are not used
di (1 or 0), ci is not used anddi is used with outputdi
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4. Digital Output

• 1 digital output channelD0 with 8 digital output linesd0− d7

• Block input: decimal representation of digital signal

• Board output:0− 5 V digital signal
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d7

d0

u7

u0

···

128 d7 + 64 d6 + 32 d5 + 16 d4 + 8 d3 + 4 d2 + 2 d1 + 1 d0 = v & 0× 00FF

ui =







di (1 or 0), ci is not used anddi is used (di is checked)
0, ci anddi are not used
ci (1 or 0), ci is used with inputci
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5. Encoder Input

• 4 encoder input channelsE0− E3 with quadrature inputsE0 A, E0 B− E3 A, E3 B

• Board input:0− 5 V digital encoder signals

• Block output: position or velocity of encoder

• Resolution:16 bit per sampling interval

• Scan rate:307.0833 kHz

• π/2/n rad maximum position quantization error and153541.6667π/n rad/s maximum measurable

angular speed (n is the encoder resolution)
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resolutionn
positionθ
velocity ω

a
b

E0 A
E0 B

position mode ⇒ v ≈ θ

velocity mode ⇒ v ≈ ω
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6. Stepper Output

• 4 stepper output channelF0− F3 with quadrature outputsF0 A, F0 B− F3 A, F3 B

• Block input: position or velocity of stepper

• Board output:0− 5 V digital stepper signals

• Resolution:16 bit per sampling interval

• Update rate:28.7891 kHz

• π/2/n rad maximum position interpolation error and899.6582π/n rad/s maximum achievable

angular speed (n is the stepper resolution)
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velocity ω
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position mode ⇒ θ ≈ v

velocity mode ⇒ ω ≈ v
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7. Capture Input

• 4 capture input channelsG0−G3

• Board input:0− 5 V digital signal

• Block output: period or frequency of digital signal

• Resolution:16 bit

• Accuracy:2.1710 µs

• 2.1710 µs maximum period quantization error andf−460625/⌊460625/f⌋ Hz maximum frequency

quantization error (f is the actual input frequency)
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SIMLAB Simulink
periodτ
frequencyf

period mode ⇒ v ≈







142.2763 × 10−3, τ ≥ 142.2763 × 10−3

τ, 34.7354 × 10−6 < τ < 142.2763 × 10−3

34.7354 × 10−6, τ ≤ 34.7354 × 10−6

frequency mode ⇒ v ≈







28789.0625, f ≥ 28789.0625
f, 7.0286 < f < 28789.0625
7.0286, f ≤ 7.0286
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8. Frequency Output

• 4 frequency output channelsH0−H3

• Block input: period or frequency of digital signal

• Board output:0− 5 V digital signal

• Resolution:16 bit

• Accuracy:2.1710 µs

• 2.1710 µs maximum period interpolation error andf−460625/⌊460625/f⌋ Hz maximum frequency

interpolation error (f is the desired output frequency)
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periodτ
frequencyf

period mode ⇒ τ ≈







142.2763 × 10−3, v ≥ 142.2763 × 10−3

v, 34.7354 × 10−6 < v < 142.2763 × 10−3

34.7354 × 10−6, v ≤ 34.7354 × 10−6

frequency mode ⇒ f ≈







28789.0625, v ≥ 28789.0625
v, 7.0286 < v < 28789.0625
7.0286, v ≤ 7.0286
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9. Sensor Input

• 4 sensor input channelsI0− I3

• Board input:0− 5 V digital signal

• Block output: pulse width or duty cycle of digital signal

• Resolution:16 bit

• Frequency range:7.0286 Hz ≤ f ≤ 1799.3164 Hz

• 2.1710 µs maximum pulse width quantization error and2.1710 × 10−6f maximum duty cycle

quantization error (f is the actual input frequency)
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SIMLAB Simulinkfrequencyf
pulse widthw
duty cycleδ

width mode ⇒ v ≈







1/f − 34.7354 × 10−6, w ≥ 1/f − 34.7354 × 10−6

w, 34.7354 × 10−6 < w < 1/f − 34.7354 × 10−6

34.7354 × 10−6, w ≤ 34.7354 × 10−6

duty mode ⇒ v ≈







1− 34.7354 × 10−6f, δ ≥ 1− 34.7354 × 10−6f
δ, 34.7354 × 10−6f < δ < 1− 34.7354 × 10−6f
34.7354 × 10−6f, δ ≤ 34.7354 × 10−6f
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10. Servo Output

• 4 servo output channelsJ0− J3

• Block input: pulse width or duty cycle of digital signal

• Board output:0− 5 V digital signal

• Resolution:16 bit

• Frequency range:7.0286 Hz ≤ f ≤ 1799.3164 Hz

• 2.1710 µs maximum pulse width interpolation error and2.1710 × 10−6f maximum duty cycle

interpolation error (f is the desired output frequency)
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SIMLABSimulink frequencyf
pulse widthw
duty cycleδ

width mode ⇒ w ≈







1/f − 34.7354 × 10−6, v ≥ 1/f − 34.7354 × 10−6

v, 34.7354 × 10−6 < v < 1/f − 34.7354 × 10−6

34.7354 × 10−6, v ≤ 34.7354 × 10−6

duty mode ⇒ δ ≈







1− 34.7354 × 10−6f, v ≥ 1− 34.7354 × 10−6f
v, 34.7354 × 10−6f < v < 1− 34.7354 × 10−6f
34.7354 × 10−6f, v ≤ 34.7354 × 10−6f
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11. Pulse Input

• 4 pulse input channelsK0−K3

• Board input:0− 5 V digital signal

• Block output: normal or shifted duty cycle of digital signal

• Resolution:16 bit

• Frequency range:56.2286 Hz ≤ f ≤ 14394.5313 Hz

• 271.3704×10−9f maximum normal duty cycle quantization error and542.7408×10−9f maximum

shifted duty cycle quantization error (f is the actual input frequency)
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frequencyf
duty cycleδ

duty mode ⇒ v ≈







1− 4.3419 × 10−6f, δ ≥ 1− 4.3419 × 10−6f
δ, 4.3419 × 10−6f < δ < 1− 4.3419 × 10−6f
4.3419 × 10−6f, δ ≤ 4.3419 × 10−6f

shifted mode ⇒ v ≈







+1− 8.6839 × 10−6f, δ ≥ 1− 4.3419 × 10−6f
2δ − 1, 4.3419 × 10−6f < δ < 1− 4.3419 × 10−6f
−1 + 8.6839 × 10−6f, δ ≤ 4.3419 × 10−6f
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12. Pulse Output

• 4 pulse output channelsL0− L3

• Block input: normal or shifted duty cycle of digital signal

• Board output:0− 5 V digital signal

• Resolution:16 bit

• Frequency range:56.2286 Hz ≤ f ≤ 14394.5313 Hz

• 271.3704×10−9f maximum normal duty cycle interpolation error and542.7408×10−9f maximum

shifted duty cycle interpolation error (f is the desired output frequency)
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frequencyf
duty cycleδ

duty mode ⇒ δ ≈







1− 4.3419 × 10−6f, v ≥ 1− 4.3419 × 10−6f
v, 4.3419 × 10−6f < v < 1− 4.3419 × 10−6f
4.3419 × 10−6f, v ≤ 4.3419 × 10−6f

shifted mode ⇒ δ ≈







1− 4.3419 × 10−6f, v ≥ +1− 8.6839 × 10−6f
v/2 + 1/2, −1 + 8.6839 × 10−6f < v < +1− 8.6839 × 10−6f
4.3419 × 10−6f, v ≤ −1 + 8.6839 × 10−6f
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13. Fast Pulse Input

• 4 fast pulse input channelsM0−M3

• Board input:0− 5 V digital signal

• Block output: normal or shifted duty cycle of digital signal

• Resolution:16 bit

• Frequency range:449.8291 Hz ≤ f ≤ 115156.25 Hz

• 33.9213 × 10−9f maximum normal duty cycle quantization error and67.8426 × 10−9f maximum

shifted duty cycle quantization error (f is the actual input frequency)
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SIMLAB Simulink
frequencyf
duty cycleδ

normal mode ⇒ v ≈







1, δ ≥ 1 (u is high)
δ, 0 < δ < 1
0, δ ≤ 0 (u is low)

shifted mode ⇒ v ≈







+1, δ ≥ 1 (u is high)
2δ − 1, 0 < δ < 1
−1, δ ≤ 0 (u is low)
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14. Fast Pulse Output

• 4 fast pulse output channelsN0−N3

• Block input: normal or shifted duty cycle of digital signal

• Board output:0− 5 V digital signal

• Resolution:16 bit

• Frequency range:449.8291 Hz ≤ f ≤ 115156.25 Hz

• 33.9213 × 10−9f maximum normal duty cycle interpolation error and67.8426 × 10−9f maximum

shifted duty cycle interpolation error (f is the desired output frequency)
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frequencyf
duty cycleδ

normal mode ⇒ δ ≈







1 (u is high), v ≥ 1
v, 0 < v < 1
0 (u is low), v ≤ 0

shifted mode ⇒ δ ≈







1 (u is high), v ≥ +1
v/2 + 1/2, −1 < v < +1
0 (u is low), v ≤ −1
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15. General Pulse Input

• 4 general pulse input channelsO0−O3

• Board input:0− 5 V digital signal

• Block output: period or frequency and pulse width or duty cycle of digital signal

• Resolution:16 bit

• Frequency range:7.0286 Hz ≤ f ≤ 1799.3164 Hz or 56.2286 Hz ≤ f ≤ 14394.5313 Hz

• 2.1710 µs or 271.3704 ns maximum period quantization error andf − 460625/⌊460625/f⌋ Hz

or f − 3685000/⌊3685000/f⌋ Hz maximum frequency quantization error (f is the actual input

frequency)

• 2.1710 µs or271.3704 ns maximum pulse width quantization error and2.1710×10−6f or 271.3704×

10−9f maximum duty cycle quantization error (f is the actual input frequency)
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periodτ
frequencyf
pulse widthw
duty cycleδ
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period and width mode ⇒

v1 ≈







142.2763 × 10−3/κ, τ ≥ 142.2763 × 10−3/κ
τ, 555.7666 × 10−6/κ < τ < 142.2763 × 10−3/κ
555.7666 × 10−6/κ, τ ≤ 555.7666 × 10−6/κ

v2 ≈







1/f − 34.7354 × 10−6/κ, w ≥ 1/f − 34.7354 × 10−6/κ
w, 34.7354 × 10−6/κ < w < 1/f − 34.7354 × 10−6/κ
34.7354 × 10−6/κ, w ≤ 34.7354 × 10−6/κ

period and duty mode ⇒

v1 ≈







142.2763 × 10−3/κ, τ ≥ 142.2763 × 10−3/κ
τ, 555.7666 × 10−6/κ < τ < 142.2763 × 10−3/κ
555.7666 × 10−6/κ, τ ≤ 555.7666 × 10−6/κ

v2 ≈







1− 34.7354 × 10−6f/κ, δ ≥ 1− 34.7354 × 10−6f/κ
δ, 34.7354 × 10−6f/κ < δ < 1− 34.7354 × 10−6f/κ
34.7354 × 10−6f/κ, δ ≤ 34.7354 × 10−6f/κ

frequency and width mode⇒

v1 ≈







1799.3164κ, f ≥ 1799.3164κ
f, 7.0286κ < f < 1799.3164κ
7.0286κ, f ≤ 7.0286κ

v2 ≈







1/f − 34.7354 × 10−6/κ, w ≥ 1/f − 34.7354 × 10−6/κ
w, 34.7354 × 10−6/κ < w < 1/f − 34.7354 × 10−6/κ
34.7354 × 10−6/κ, w ≤ 34.7354 × 10−6/κ

frequency and duty mode ⇒

v1 ≈







1799.3164κ, f ≥ 1799.3164κ
f, 7.0286κ < f < 1799.3164κ
7.0286κ, f ≤ 7.0286κ

v2 ≈







1− 34.7354 × 10−6f/κ, δ ≥ 1− 34.7354 × 10−6f/κ
δ, 34.7354 × 10−6f/κ < δ < 1− 34.7354 × 10−6f/κ
34.7354 × 10−6f/κ, δ ≤ 34.7354 × 10−6f/κ

κ = 1 when7.0286 Hz − 1799.3164 Hz frequency range selected

κ = 8 when56.2286 Hz − 14394.5313 Hz frequency range selected
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16. General Pulse Output

• 4 general pulse output channelsP0− P3

• Block input: period or frequency and pulse width or duty cycle of digital signal

• Board output:0− 5 V digital signal

• Resolution:16 bit

• Frequency range:7.0286 Hz ≤ f ≤ 1799.3164 Hz or 56.2286 Hz ≤ f ≤ 14394.5313 Hz

• 2.1710 µs or 271.3704 ns maximum period interpolation error andf − 460625/⌊460625/f⌋ Hz

or f − 3685000/⌊3685000/f⌋ Hz maximum frequency interpolation error (f is the desired output

frequency)

• 2.1710 µs or271.3704 ns maximum pulse width interpolation error and2.1710×10−6f or 271.3704×

10−9f maximum duty cycle interpolation error (f is the desired output frequency)
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periodτ
frequencyf
pulse widthw
duty cycleδ
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period and width mode ⇒

τ ≈







142.2763 × 10−3/κ, v1 ≥ 142.2763 × 10−3/κ
v1, 555.7666 × 10−6/κ < v1 < 142.2763 × 10−3/κ
555.7666 × 10−6/κ, v1 ≤ 555.7666 × 10−6/κ

w ≈







1/f − 34.7354 × 10−6/κ, v2 ≥ 1/f − 34.7354 × 10−6/κ
v2, 34.7354 × 10−6/κ < v2 < 1/f − 34.7354 × 10−6/κ
34.7354 × 10−6/κ, v2 ≤ 34.7354 × 10−6/κ

period and duty mode ⇒

τ ≈







142.2763 × 10−3/κ, v1 ≥ 142.2763 × 10−3/κ
v1, 555.7666 × 10−6/κ < v1 < 142.2763 × 10−3/κ
555.7666 × 10−6/κ, v1 ≤ 555.7666 × 10−6/κ

δ ≈







1− 34.7354 × 10−6f/κ, v2 ≥ 1− 34.7354 × 10−6f/κ
v2, 34.7354 × 10−6f/κ < v2 < 1− 34.7354 × 10−6f/κ
34.7354 × 10−6f/κ, v2 ≤ 34.7354 × 10−6f/κ

frequency and width mode⇒

f ≈







1799.3164κ, v1 ≥ 1799.3164κ
v1, 7.0286κ < v1 < 1799.3164κ
7.0286κ, v1 ≤ 7.0286κ

w ≈







1/f − 34.7354 × 10−6/κ, v2 ≥ 1/f − 34.7354 × 10−6/κ
v2, 34.7354 × 10−6/κ < v2 < 1/f − 34.7354 × 10−6/κ
34.7354 × 10−6/κ, v2 ≤ 34.7354 × 10−6/κ

frequency and duty mode ⇒

f ≈







1799.3164κ, v1 ≥ 1799.3164κ
v1, 7.0286κ < v1 < 1799.3164κ
7.0286κ, v1 ≤ 7.0286κ

δ ≈







1− 34.7354 × 10−6f/κ, v2 ≥ 1− 34.7354 × 10−6f/κ
v2, 34.7354 × 10−6f/κ < v2 < 1− 34.7354 × 10−6f/κ
34.7354 × 10−6f/κ, v2 ≤ 34.7354 × 10−6f/κ

κ = 1 when7.0286 Hz − 1799.3164 Hz frequency range selected

κ = 8 when56.2286 Hz − 14394.5313 Hz frequency range selected
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17. Logic Input

• 1 logic input channelQ0 with 8 logic functions (or,nor, and,nand, exor, exnor,buffer, inverter)

• Board input:0− 5 V digital signal

• Board output:0− 5 V digital signal

• Block output: ignored

• Propagation delay:4 µs in slow mode and1 µs in fast mode
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A
/G
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E
0
B
/G

1

E
1
A
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2
E
1
B
/G

3

E
2
A

E
2
B

E
3
A

E
3
B

V
D
D

V
D
D

V
D
D

V
D
D

G
N
D

G
N
D

G
N
D

G
N
D

Q0

CON3

Logic Input

E3 B
Q0

E0 A

F0 A

F3 B

u7

u0

v7

v0

···
···

v

SIMLAB Simulink

slow mode or fast mode⇒

v0 = u0 + u1, v1 = u0 + u1

v2 = u2 · u3, v3 = u2 · u3

v4 = u4 ⊕ u5, v5 = u4 ⊙ u5

v6 = u6, v7 = u7
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18. Logic Output

• 1 logic output channelR0 with 8 logic functions (or,nor, and,nand, exor, exnor,buffer, inverter)

• Block input: ignored

• Board input:0− 5 V digital signal

• Board output:0− 5 V digital signal

• Propagation delay:4 µs in slow mode and1 µs in fast mode

F0 A/H0
F0 B/H1

F1 A/H2
F1 B/H3

F2 A
F2 B

F3 A
F3 B

VDD

VDD

VDD

VDD

GND

GND

GND

GND

R0

C
O

N
5

Logic Output

F3 B
R0

F0 A

E0 A

E3 B

u7

u0

v7

v0

···
···v

SIMLABSimulink

slow mode or fast mode⇒

u0 = v0 + v1, u1 = v0 + v1

u2 = v2 · v3, u3 = v2 · v3

u4 = v4 ⊕ v5, u5 = v4 ⊙ v5

u6 = v6, u7 = v7
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19. Counter Input

• 4 counter input channelsS0− S3

• Board input:0− 5 V digital signal

• Block output: number of rising or falling edges of digital signal

• 16 bit register length and minimum271.3704 ns separation

replacements
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/G
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B
/G
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B

V
D
D

V
D
D

V
D
D

V
D
D

G
N
D

G
N
D

G
N
D

G
N
D

S0

CON3

Counter Input

S0G0u v

SIMLAB Simulink
n+ ⌋⌈↑ transitions
n− ⌉⌊↓ transitions

rising mode ⇒ v = n+

falling mode ⇒ v = n−
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20. Timer Output

• 4 timer output channelsT0− T3

• Block input: number of rising or falling edges of digital signal

• Board output:0− 5 V digital signal

• 16 bit register length and488.2972 µs separation

F0 A/H0
F0 B/H1

F1 A/H2
F1 B/H3

F2 A
F2 B

F3 A
F3 B

VDD

VDD

VDD

VDD

GND

GND

GND

GND

T0

C
O

N
5

Timer Output

T0 H0 uv

SIMLABSimulink
n+ ⌋⌈↑ transitions
n− ⌉⌊↓ transitions

rising mode ⇒ n+ = v

falling mode ⇒ n− = v
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21. File Input

• 16 file input channelsLOG y.log (file name) with input fileY0.log −YF.log

• File input: data in float64, float32, int64, uint64, int32, uint32, int16, uint16, int8 or uint8 format

• Block output: data read from file input

Y0.log
LOG

file

File Input

Y0.log
Y0.log
LOG

u
v

SimulinkFile

float64 mode ⇒ v = float64(u)

float32 mode ⇒ v = float32(u)

int64 mode ⇒ v = int64(u)

uint64 mode ⇒ v = uint64(u)

int32 mode ⇒ v = int32(u)

uint32 mode ⇒ v = uint32(u)

int16 mode ⇒ v = int16(u)

uint16 mode ⇒ v = uint16(u)

int8 mode ⇒ v = int8(u)

uint8 mode ⇒ v = uint8(u)

23



22. File Output

• 16 file output channelsLOG z.log (file name) with output fileZ0.log − ZF.log

• Block input: data to be written to file output

• File output: data in float64, float32, int64, uint64, int32, uint32, int16, uint16, int8 or uint8 format

Z0.log
LOG

file

File Output

Z0.log
Z0.log
LOG

u
v

Simulink File

float64 mode ⇒ u = float64(v)

float32 mode ⇒ u = float32(v)

int64 mode ⇒ u = int64(v)

uint64 mode ⇒ u = uint64(v)

int32 mode ⇒ u = int32(v)

uint32 mode ⇒ u = uint32(v)

int16 mode ⇒ u = int16(v)

uint16 mode ⇒ u = uint16(v)

int8 mode ⇒ u = int8(v)

uint8 mode ⇒ u = uint8(v)
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23. UDP Input

• 65536 UDP input channelsUDP y.y.y.y (IP address) with local port0− 65535

• UDP input: data in float64, float32, int64, uint64, int32, uint32, int16, uint16, int8 or uint8 format

• Block output: data read from local port

127.0.0.1
UDP

local port

UDP Input

127.0.0.1
UDP

UDP port

u
v

Simulink

local port

float64 mode ⇒ v = float64(u)

float32 mode ⇒ v = float32(u)

int64 mode ⇒ v = int64(u)

uint64 mode ⇒ v = uint64(u)

int32 mode ⇒ v = int32(u)

uint32 mode ⇒ v = uint32(u)

int16 mode ⇒ v = int16(u)

uint16 mode ⇒ v = uint16(u)

int8 mode ⇒ v = int8(u)

uint8 mode ⇒ v = uint8(u)
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24. UDP Output

• 65536 UDP output channelsUDP z.z.z.z (IP address) with remote port0− 65535

• Block input: data to be written to remote port

• UDP output: data in float64, float32, int64, uint64, int32, uint32, int16, uint16, int8 or uint8 format

127.0.0.1
UDP

remote port

UDP Output

127.0.0.1
UDP

UDP port

u
v

Simulink

remote port

float64 mode ⇒ u = float64(v)

float32 mode ⇒ u = float32(v)

int64 mode ⇒ u = int64(v)

uint64 mode ⇒ u = uint64(v)

int32 mode ⇒ u = int32(v)

uint32 mode ⇒ u = uint32(v)

int16 mode ⇒ u = int16(v)

uint16 mode ⇒ u = uint16(v)

int8 mode ⇒ u = int8(v)

uint8 mode ⇒ u = uint8(v)

26



25. COM Input

• 256 COM input channelsCOM y (COM port) with receive port1− 256

• COM input: data in float64, float32, int64, uint64, int32, uint32, int16, uint16, int8 or uint8 format

• Block output: data read from receive port

5
COM

receive port

COM Input

5
COM

COM port

u
v

Simulink

receive port

float64 mode ⇒ v = float64(u)

float32 mode ⇒ v = float32(u)

int64 mode ⇒ v = int64(u)

uint64 mode ⇒ v = uint64(u)

int32 mode ⇒ v = int32(u)

uint32 mode ⇒ v = uint32(u)

int16 mode ⇒ v = int16(u)

uint16 mode ⇒ v = uint16(u)

int8 mode ⇒ v = int8(u)

uint8 mode ⇒ v = uint8(u)
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26. COM Output

• 256 COM output channelsCOM z (COM port) with transmit port1− 256

• Block input: data to be written to transmit port

• COM output: data in float64, float32, int64, uint64, int32, uint32, int16, uint16, int8 or uint8 format

5
COM

transmit port

COM Output

5
COM

COM port

u
v

Simulink

transmit port

float64 mode ⇒ u = float64(v)

float32 mode ⇒ u = float32(v)

int64 mode ⇒ u = int64(v)

uint64 mode ⇒ u = uint64(v)

int32 mode ⇒ u = int32(v)

uint32 mode ⇒ u = uint32(v)

int16 mode ⇒ u = int16(v)

uint16 mode ⇒ u = uint16(v)

int8 mode ⇒ u = int8(v)

uint8 mode ⇒ u = uint8(v)
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27. H-bridge Power Output

• 4 H-bridge power output channelsP0 A, P0 B− P3 A, P3 B

• Board output:0− VS V digital power signal (VS is the power supply voltage)

• Capacity:5 A

• H-bridge power outputs can be used as power amplifiers to drive heavy loads and stepper motors

replacements

N0
P0 A

P0 B
v

+

−

u1/VS

SIMLABSimulink

Z

N0 in normal mode ⇒ lowpass equivalent ofu ≈







+VS, v ≥ VS

2v − VS , 0 < v < VS

−VS, v ≤ 0

N0 in shifted mode ⇒ lowpass equivalent ofu ≈







+VS, v ≥ +VS

v, −VS < v < +VS

−VS, v ≤ −VS

F0

P0 A
P0 B
P1 A
P1 B

v

a

b c d
θ ω

SIMLABSimulink S

F0 in position mode ⇒ θ ≈ v

F0 in velocity mode ⇒ ω ≈ v
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28. Pulse Filtering

• Lowpass filtered pulse outputs can be used as analog outputs

• Bandwidth of the lowpass filter should be sufficiently small (much smaller than the fundamental

frequency of the pulse output)

N0 H0v

u

1/5

SIMLABSimulink

R

C

+

−

N0 in normal mode ⇒ lowpass equivalent ofu ≈







5, v ≥ 5
v, 0 < v < 5
0, v ≤ 0

N0 in shifted mode ⇒ lowpass equivalent ofu ≈







5, v ≥ +5
v/2 + 5/2, −5 < v < +5
0, v ≤ −5

N0 H0v u1/5 G(s)

SIMLABSimulink

N0 in normal mode ⇒ lowpass equivalent ofU(s) ≈ G(s)V (s)

N0 in shifted mode ⇒ lowpass equivalent ofU(s) ≈ G(s)[V (s)/2 + 5/2/s]
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29. Level Conversion

• Negative voltage levels can not be applied directly to the analog inputs and negative voltage levels

can not be obtained directly from the analog outputs

• Two simple level converter circuits to convert voltage levels are shown below

10 k

10 k
+

−

u
v

+5 V

+5 V

A0 A0

SIMLAB Simulink

A0 in unipolar mode ⇒ v ≈







5, u ≥ +5,
u/2 + 5/2, −5 < u < +5,
0, u ≤ −5

A0 in bipolar mode ⇒ v ≈







+5, u ≥ +5,
u, −5 < u < +5,
−5, u ≤ −5

10 k

10 k

+

−
u

v

−5 V

B0B0

+5 V

+5 V
SIMLABSimulink

B0 in unipolar mode ⇒ u ≈







+5, v ≥ 5,
2v − 5, 0 < v < 5,
−5, v ≤ 0

B0 in bipolar mode ⇒ u ≈







+5, v ≥ +5,
v, −5 < v < +5,
−5, v ≤ −5
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30. Sampling Rate

• Serial link

number of input channelsni ≤ 64

number of output channelsno ≤ 64
⇒ sampling ratef =

1

T
≤

46080

2max(ni, no) + 1

• USB link

number of input channelsni ≤ 64

number of output channelsno ≤ 64
⇒ sampling ratef =

1

T
≤ 1024

• Wireless link

number of input channelsni ≤ 64

number of output channelsno ≤ 64
⇒ sampling ratef =

1

T
≤

11520

2ni + 2no + 7
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31. Usage

• Set up the real-time control board with the desired externalconnections and construct a Simulink

model with the desired blocks.

• Define the sample timeT (T = 1/f , wheref is the sampling rate) and the stop timeS at the

command prompt in the Matlab command window.

• Build the Simulink model by clicking on “Tools→ Code Generation→ Build Model” or by pressing

Ctrl+B.

• Click on the “Connect to target” button to connect the board to the model and then click on the

“Start real-time code” button to run the model.

• Click on the “Stop real-time code” button to stop the model or click on the “Disconnect from

target” button to disconnect the model from the board.

• If the real-time execution is terminated by clicking on the “Stop real-time code” button , the

model can be modified, rebuilt and rerun by following the above steps again.

• If, however, the real-time execution is terminated by clicking on the “Disconnect from target” button

, the board must be reset before rerunning the model even without any modification since the

code is still running on the real-time board.

• Pressing the reset button on the board also stops the real-time execution when the board is used

with the serial port.
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32. Guidelines

• Refer to the examples that come with the platform for settingup the configuration parameters under

“Simulation→ Configuration Parameters...” for your model.

• Refer to the Matlab help files for setting up the configurationparameters under “Tools→ External

Mode Control Panel...” for your model.

• Refer to the Real-Time Windows Target help files for setting up the “Scope parameters” for external

data collection.

• Confine all your project files to the SIMLAB installation folder and make sure that the “Current

Folder” of Matlab is your SIMLAB installation folder.

• Make sure that the com port number of each SIMLAB block (default is 5) matches with the com

port you are using.

• Rebuild your model whenever you make any changes in the parameters of the SIMLAB blocks in

your model (even when Matlab does not warn you to do so).

• Fast pulse input can not be used together with pulse input, pulse output, fast pulse output, general

pulse input and general pulse output in the same Simulink model.

• Fast pulse output can not be used together with pulse input, pulse output, fast pulse input, general

pulse input and general pulse output in the same Simulink model.

• All relevant physical quantities (board and block inputs, outputs and parameters) cited in this

document are in SI units for convenience.

• The given quantization and interpolation errors are based on the nominal values of components used

on the SIMLAB board and are provided only for reference purpose (not guaranteed).

• Do not excessively load (actively or passively) the inputs and outputs of the board beyond their

normal operating ranges.

• Refer to the data sheets of the components used on the board for their absolute maximum ratings

and safe operating areas.
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33. Applications

• Real-time signal analysis, synthesis, processing and visualization

• Parameter tuning and optimization

• Modeling, analysis and design of control systems

• Real-time control

• Hardware-in-the-loop simulation

• Real-time rapid control prototyping

• Teaching concepts and carrying out experiments in signals and systems labs

• Real-time data acquisition
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34. Specifications

• Power supply:6− 15 V, minimum 0.25 A, regulated

• Interface: UART (serial) link, USB link or wireless link

• Analog input:A0−A7, 0− 5 V analog,12 bit resolution

• Analog output:B0− B7, 0− 5 V analog,12 bit resolution

• Digital input: C0 (c0 − c7), 0− 5 V digital, 8 lines

• Digital output:D0 (d0− d7), 0− 5 V digital, 8 lines

• Encoder input:E0 A,E0 B− E3 A,E3 B, 0− 5 V digital, 16 bit resolution

• Stepper output:F0 A,F0 B− F3 A,F3 B, 0− 5 V digital, 16 bit resolution

• Capture input:G0−G3, 0− 5 V digital, 16 bit resolution

• Frequency output:H0−H3, 0− 5 V digital, 16 bit resolution

• Sensor input:I0− I3, 0− 5 V digital, 16 bit resolution

• Servo output:J0− J3, 0− 5 V digital, 16 bit resolution

• Pulse input:K0−K3, 0− 5 V digital, 16 bit resolution

• Pulse output:L0− L3, 0− 5 V digital, 16 bit resolution

• Fast pulse input:M0−M3, 0− 5 V digital, 16 bit resolution

• Fast pulse output:N0−N3, 0− 5 V digital, 16 bit resolution

• General pulse input:O0−O3, 0− 5 V digital, 16 bit resolution

• General pulse output:P0− P3, 0− 5 V digital, 16 bit resolution

• Logic input:Q0, 0− 5 V digital, 8 logic functions

• Logic output:R0, 0− 5 V digital, 8 logic functions

• Counter input:S0− S3, 0− 5 V digital, 16 bit counter

• Timer output:T0− T3, 0− 5 V digital, 16 bit timer

• Test input:U0−U7 (used for test purpose)

• Test output:V0−V7 (used for test purpose)

• Reserved input:W0−W7 (reserved for future use)

• Reserved output:X0−X7 (reserved for future use)

• File input: LOG y.log, 8/64 bit format

• File output:LOG z.log, 8/64 bit format

• UDP input:UDP 127.0.0.1, 8/64 bit format

• UDP output:UDP 127.0.0.1, 8/64 bit format

• COM input:COM 5, 8/64 bit format

• COM output:COM 5, 8/64 bit format

• H-bridge:P0 A,P0 B− P3 A,P3 B, 0− (supply voltage) V digital,5 A

• Peripheral: WRT, IIC, SPI, CAN and DCI (optional)

• Regulator:VDD, 5 V, 0.25 A
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• Ground:GND, 0 V

• Sampling rate: up to15.2 kHz

• Size:12.70 cm × 10.16 cm

• Weight: 72.5 g
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35. Requirements

• PC with Windows XP or later and an expansion slot for a serial card or a USB port

• Matlab R2007b or later with Simulink, Real-Time Workshop (Matlab Coder and Simulink Coder)

and Real-Time Windows Target (Simulink Desktop Real-Time)

• SIMLAB hardware (real-time control board) 1.1 or later

• SIMLAB software 1.1 or later

• Serial crossover cable or USB cable

• Power supply (regulated,6− 15 V and at least0.25 A)
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36. Absolute Maximum Ratings

• Power supply voltage: minimum3 V, maximum16 V

• Each analog and digital input: minimum−0.3 V, maximum+5.3 V

• Each analog and digital output: minimum−25 mA, maximum+25 mA

• Each H-bridge power output: minimum−5 A, maximum+5 A

• Voltage regulator output: maximum0.5 A (total)

• Total current from/into all inputs and outputs (except power supply, voltage regulator and H-bridges):

minimum −200 mA, maximum+200 mA

• Operating ambient temperature: minimum10 ◦C, maximum50 ◦C
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